
Images and Colour with CSS

Design for web content



4 common raster formats

• JPEG (Joint Photographic Experts Group)
• GIF (Graphics Interchange Format)
• PNG-8 (Portable Network Graphics 8bit)
• PNG-24 (Portable Network Graphics 24bit)



What about WebP?

WebP is a (relatively) new image file format, promoted by Google. It promises 
smaller files and good control over compression. However, despite being around 
since 2010, support for the format is sketchy. Although support in Chrome and 
Firefox has been good for years, Safari only implemented full suppoer in 
September 2022. Of course, older browsers like IE are not compatible.
Photoshop does have “save as” support the format but it’s not an option on the 
“export” modal.
WebP is one to watch for the future, especially as sustainability gets traction in 
web design.

https://en.wikipedia.org/wiki/WebP


WebP browser compatibility

https://caniuse.com/webp October 2022

https://caniuse.com/webp


Colour Depth

• JPEG True Colour (24 bit)
• GIF 256 colours (8 bit)
• PNG-8 256 colours (8 bit)
• PNG-24 True Colour (24 bit)

“True” colour image formats like JPEG can display around 
16 million colours (16,777,216 to be precise, that’s 256 
red x 256 green x 256 blue). Since the human eye is 
capable of discerning fewer colours than this, true colour 
images are equivalent to what we see in the real world.
256 colour images are sometimes referred to as using an 
“indexed” colour palette.

http://en.wikipedia.org/wiki/Color_depth

http://en.wikipedia.org/wiki/Color_depth


256 Colour Dithering

File formats with 256 colour palettes (GIF & 
PNG-8) are not good for photographic 
images. 
They use a process called “dithering” to 
simulate additional colours.

http://en.wikipedia.org/wiki/Dither

http://en.wikipedia.org/wiki/Dither


Killer Feature

• JPEG Variable compression
• GIF Frame animation
• PNG-8 Smaller than equivalent GIF
• PNG-24 Alpha transparency

You might wonder why we need 4 different file formats 
for web design work. Well, they all have different 
attributes and each one has a “killer” feature that the 
others don’t and this makes them useful in different 
situations.



JPEG Compression

The JPEG file format is particularly good for 
photographs because it has a “true colour” 
palette and variable compression algorithm 
that can be used to control file size.
Over-compression can result in “artefacts” 
appearing in the image.



Image Quality vs JPEG File Size

Original image size : 2912px x 3264px reduced to 400px x 600px for use on web

Original file size: 6.12MB (612,000KB)

600px

400px
File size
JPEG 100% = 103KB
JPEG 80% = 59KB
JPEG 60% = 37KB
JPEG 40% = 26KB

PNG-24 = 463KB



Quality vs Compression

low compression = high quality high compression = low quality
Image optimisation is always a balance between image quality and file size.

100% = 463kb at 800x600px 10% = 18kb at 800x600px



Creating GIF Animation

Photoshop can be used to 
build GIF animations. Using a 
sequence of different layer 
settings for each frame, a 
simple (or complex) frame-
based animation can be 
created. The Photoshop 
Timeline palette allows the 
time between each frame to 
be varied and it will even 
tween between different layer 
states.



Transparency

• JPEG None
• GIF 1 colour
• PNG-8 1 colour
• PNG-24 Alpha channel (256 colour)

The key problem with JPEG images is the inability to 
contain transparency information. Fortunately, the 
more recent PNG-24 format can display 256 grades 
of transparency from completely transparent to 
completely opaque. This information is known as an 
“alpha channel”. In GIF and PNG-8 files, one of the 
256 colours can be designated as transparent.



Alpha transparency in IE6

Alpha transparency in IE7 and all modern browsers

PNG-24 Alpha Transparency

The use of PNG alpha transparency 
was limited by browser support (IE6 
and below do not support it).
Now that IE6 is a minority browser, it 
is possible to use this feature to great 
effect.
For example, a foreground image can 
be given a gradient fade that will work 
with any background colour or image.



Best used for...

• JPEG Photographs
• GIF Simple graphics or animation
• PNG-8 Simple graphics (often smaller than GIF)

• PNG-24 Complex graphics (photo & line art)

Each format has a specific use, so make sure 
you’re using the correct format for the type of 
image you want to present. Using the wrong 
format will mean using files that are too large or 
images of poor quality.



Image type

PNG file used for graphic images JPEG file used inappropriately
The effect of JPEG compression is especially noticeable in the text of the right-hand image.

512x512px 512x512px



Set your image size...

When working with raster images 
for web, it’s a good idea to set 
your Photoshop rulers to “pixels” 
(Edit > Preferences > Units & 
Rulers...) because that’s the most 
convenient unit type for our work.

You can then resize your image 
(Image > Image Size...) by entering 
either the required width or 
height value in the dialogue box. 
By default the aspect ratio is 
locked (small chain-link symbol), 
so changing either the width or 
the height will result in a 
proportionally scaled image.



Save for Web...
Photoshop has a special tool 
for helping us to save our 
images ready for the web. It 
offers a choice of all 4 
formats of interest to us and 
it can give us previews of 
how the image will look 
once it is saved. It can also 
tell us how big each file will 
be and how long it will take 
to download.
Curiously, Photoshop CC 
now considers this to be a 
“legacy” feature but it 
remains the best tool for the 
job. The new Export As…
tool has similar features.

File > Export > Save for Web (Legacy)…



Unlike all the other image formats 
we have talked about so far, SVG 
images use vectors rather than 
pixels. In other words, SVGs are 
created using coordinates rather 
than a matrix of coloured squares.
SVGs use the XML markup language 
and can therefore be embedded 
within HTML if required, unlike 
raster images that must be linked.
The most obvious advantage of SVG 
images is that they are infinitely 
scalable and the quality does not 
degrade as they get larger. Ideal for 
responsive web design.

SVG on the Web – A Practical Guide

The web standards model

Content
Text, images, ...

Structure
HTML

Presentation
CSS

Behaviour
JavaScript

Scalable Vector Graphics

https://svgontheweb.com/


Image positioning with CSS



CSS Floats

CSS floats are one of the most powerful tools we 
have to control the relative position of HTML 
elements within a page. You're going to be using 
them a lot for controlling page layouts but for 
now, let's consider their use for placing images 
within columns of text.

By default, images will just run inline with text 
(they are inline elements) but if we apply a CSS 
float property rule to them, we can control where 
they appear in relation to the surrounding text.

Floating an image to the right causes text to flow 
to the left and vice versa.

http://alistapart.com/article/css-floats-101

http://alistapart.com/article/css-floats-101


Left Placement

<img src="images/artichoke.jpg" width="200" height="200" alt="Artichoke">

img {
float: left;
margin: 7px 20px 10px 0;

}



Right Placement

<img src="images/artichoke.jpg" width="200" height="200" alt="Artichoke">

img {
float: right;
margin: 7px 0 10px 20px;

}



Centre Placement

<img src="images/artichoke.jpg" width="200" height="200" alt="Artichoke">

img {
display: block;
margin: 10px auto;

}

Centring an image is a bit different, we can't float centre. We 
need two declarations, one to change the image behaviour 
from inline to block and another to make the left and right 
margins equal using the auto value. 



Background Images



Background Images

<p class="background">Lorem ipsum dolor… </p>

p.background {
background: url(artichoke.jpg) no-repeat;

}

https://developer.mozilla.org/en-US/docs/Web/CSS/background

The CSS background property 
can be used to display an 
image in the background of 
an element.

Obviously, this should be 
used with caution because 
background images often 
make a design look too fussy 
or make the overlying text 
difficult to read.

In this example, an image is 
shown in the background of a 
paragraph element.

https://developer.mozilla.org/en-US/docs/Web/CSS/background


Background Repeat

<p class="background">Lorem ipsum dolor… </p>

p.background {
background: url(artichoke.jpg) repeat-x;

}

By default, all background 
images will repeat both 
vertically and horizontally 
(the X and Y directions) but 
we can control this 
behaviour using the repeat
value.

In this example, the image 
repeats only in the 
horizontal direction (X).

https://developer.mozilla.org/en-US/docs/Web/CSS/background-repeat

https://developer.mozilla.org/en-US/docs/Web/CSS/background-repeat


Background Position

<p class="background">Lorem ipsum dolor… </p>

p.background {
background: url(artichoke.jpg) no-repeat 50% 50%;

}

A single background image 
placed in the middle of the 
parent element. The position 
values (50% 50%) places the 
image half-way down and 
half-way across the element, 
effectively centring the image. 
The same effect can be 
created using the center
keyword. Keywords top, 
bottom, left and right may 
also be used.

https://developer.mozilla.org/en-US/docs/Web/CSS/background-position

https://developer.mozilla.org/en-US/docs/Web/CSS/background-position


Background Size

<p class="background">Lorem ipsum dolor… </p>

p.background {
background-image: url(golden-gate.jpg);
background-repeat: no-repeat;
background-size: cover;

}

The background property is a 
shorthand for the many 
individual background 
properties in CSS…

background-image
background-repeat
background-position
background-size

Each can be set independently.
The background-size property 
can be used with keywords to 
control how the image is 
displayed. This can be useful 
for responsive designs.

https://css-tricks.com/almanac/properties/b/background-size/

https://css-tricks.com/almanac/properties/b/background-size/


Background Image & Colour

<p class="background">Lorem ipsum dolor… </p>

p.background {
background: #D0D5C6 url(artichoke.jpg) no-repeat 50% 50%;

}

The background property 
allows us to have both a 
background image and a 
background colour on the 
same element (can be set 
independently with the 
background-color property).

CSS3 introduced the ability to 
specify multiple background 
images. See link for details.

https://developer.mozilla.org/en-US/docs/Web/CSS/CSS_Backgrounds_and_Borders/Using_multiple_backgrounds

https://developer.mozilla.org/en-US/docs/Web/CSS/CSS_Backgrounds_and_Borders/Using_multiple_backgrounds


Background Gradients

body  {
background-color: #e5edf6; /*fall-back*/
background: linear-gradient(180deg, rgba(229,237,246,1) 0%, rgba(57,89,126,1) 100%);

}

The background property can also be used 
to display a gradient. The options are 
comprehensive, so take a look at the 
documentation to find out what’s possible 
and how to implement it.

As with background images, use gradients 
responsibly!

https://developer.mozilla.org/en-US/docs/Web/CSS/CSS_Images/Using_CSS_gradients

https://developer.mozilla.org/en-US/docs/Web/CSS/CSS_Images/Using_CSS_gradients


Gradient Generators

The syntax for CSS gradients can be quite complex so, inevitably, there are lots of gradient 
generator tools to help you.

https://cssgradient.io/

https://cssgradient.io/


Colour choices



Colour Clash!



Colour Harmony



High Contrast

Low Contrast
Contrast can be used to reinforce information hierarchy



Colour contrast for accessibility

http://contrastchecker.com/

Colour choices have important usability and accessibility implications – choose wisely.

http://contrastchecker.com/


Adobe colour contrast analyzer

https://color.adobe.com/create/color-contrast-analyzer

https://color.adobe.com/create/color-contrast-analyzer


Building colour schemes



Colour from Images

Monochromatic text colour variant: Brightness and saturation



Monochromatic Schemes

Monochromatic colour schemes can be created 
using just the Saturation and Brightness sliders 
on the Photoshop colour picker.



https://color.adobe.com/create/image

Extract theme from image

https://color.adobe.com/create/image


Colour Theory

http://www.color-wheel-pro.com/color-theory-basics.html

http://www.color-wheel-pro.com/color-theory-basics.html


Other Colour Schemes

http://www.color-wheel-pro.com/color-theory-basics.html

http://www.color-wheel-pro.com/color-theory-basics.html


https://color.adobe.com/create/color-wheel

Colour Scheme Tools
There are lots of free colour 
scheme tools available 
online that can help in 
building colour palettes 
based on colour theory. 
These may be a good guide 
when you first start building 
colour pallets, but they are 
no substitute for careful 
consideration.  

https://color.adobe.com/create/color-wheel


Colour is as much a 
science as it is an art. 
Just like typography, 
it requires study.



THE END
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